
What’s New in the 2010 Baseline
SILVACO, Inc.
4701 Patrick Henry Drive, Bldg. 2  July, 2010
Santa Clara, CA 95054 
Phone (408) 567-1000
Web http://www.silvaco.com



What’s New in the 2010 Baseline
[This page is intentionally left blank.]
ii SILVACO, Inc.



Table of Contents
TCAD  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-1
VICTORY Process (New Product) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-1
VICTORY Cell (New Product)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-3
VICTORY Stress (New Product)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-3
VICTORY Device (New Product) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-4
ATHENA. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-4
ATLAS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-4
Virtual Wafer Fab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-17

Interactive Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-18
DeckBuild . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-18
Tonyplot3D . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-18
TonyPlot . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-19
DeckBuild PC . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-19
MaskViews . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-19

Analog / Mixed Signal / RF . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-20
Gateway . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-20
SmartSpice. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-23
SmartSpiceRF  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-24
Harmony. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-24
UTMOST III  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-26
UTMOST IV . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-26
SPAYN . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-28
SmartView  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-28

CUSTOM IC CAD . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-29
Expert . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-29
Guardian. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-29
HIPEX. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-30

INTERCONNECT . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-32
QUEST . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-32
CLEVER. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-32
ClarityRLC  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-32

DIGITAL CAD . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-33
SILOS. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-33
AccuCell . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-34
AccuCore . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-34
HyperFault . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-35
CatalystAD . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-36
CatalystDA . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-36
Spider . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-36

Other. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-37
SEDIT. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-37
SMAN. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-37
SRDB . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-37
SFLM . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-37
SILVACO, Inc. iii 



What’s New in the 2010 Baseline
[This page intentionally left blank]
iv SILVACO, Inc.



What’s New in the 2010 Baseline
TCAD
VICTORY Process (New Product)

VICTORY PROCESS is a general purpose 3D process simulator. VICTORY PROCESS includes a complete 
process flow core simulator and three advanced simulation modules: Monte Carlo Implant, Advanced 
Diffusion and Oxidation, and Physical Etch and Deposit. Proprietary models, as well as public domain 
research models, can be easily integrated into VICTORY PROCESS using the open modeling interface.

Key Features
• Sophisticated multi-particle and flux models for physical deposition and etching with substrate 

material redeposition.
• Extremely accurate and fast Monte Carlo implant simulation.
• Comprehensive set of 3D diffusion models: Fermi, three-stream, and five-stream.
• 3D physical oxidation simulation with stress analysis.
• Fast 3D structure prototyping capability enables the in-depth physical analysis of specific 

processing issues.
• Accurately predicts 3D topology and 3D dopant distribution.
• Automatic meshing and Adaptive Mesh Refinement.
• Efficient multi-threading of time critical operations of Monte Carlo implantation, diffusion, 

oxidation, and physical etching and deposition.
• Open architecture allows easy introduction and modification of customer specific physical models.
• Seamless link to 3D device simulators including structure mirroring, adaptive doping refinement 

and electrode specification.

Additions and Enhancements Since Initial Release
• The dopant Indium is now also supported for diffusion simulation. The diffusion data are taken 

from ATHENA as for all other dopant species.
• The material 'barrier' can now be used also with ion implantation. The dopants do not 

penetrate this 'barrier' material.
• The ions Indium, Nitrogen, Oxygen, and BF2 can now be used for ion implantation. For example:     

Implant bf2 energy=190 dose=5e13 tilt=7 rotation=20

• Added the following elements to the material database: Al, Au, Be, C, Cr, F, Ga, He, Mg, Se, Si, and 
Zn. 

• Ta2O5 (tantalum oxide) has been added to the material database. Until now, only the material ID 
of this material is stored within the material database. This means that this material can be used 
for etching/deposition process steps but will not be used for annealing process steps. 

• SiC (silicon carbide)has been added to the material database. Until now, only the material ID of 
this material is stored within the material database. This means that this material can be used for 
etching/deposition process steps but will not be used for annealing process steps. Moreover, it has 
to be noted that this material SiC will only be used if you are not aware of the actual crystalline 
structure of your SiC material. Otherwise, you should use one of the materials:  

• sic-3c  (zinc blende crystal structure)

• sic-4h  (hexagonal crystal structure)

• sic-6h  (hexagonal crystal structure)

• Added Cobalt-silicide (CoSi) to the material database. Also, the relevant interface files for 
diffusion have been added to the material database.
SILVACO, Inc. 1-1
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• The material anysemiconductor has been added to the material database. Its material ID is 186. 
Its material properties and modeling properties have been obtained from silicon. 

• Added the material hfo2 to the material database. Until now, only the material ID of this material 
is stored within the material database. This means that this material can be used for etching/
deposition process steps, but shall not be used for annealing process steps. 

• Added additional secondary source functions for redeposition during ion milling. The following 
source functions are now supported : 
• CONST: Cosine type emission around point's normal direction (default). 
• SHIFTED: Cosine type emission around prefered direction of emission. 
• LINEAR: Linear type emission around prefered direction of emission. 
• DIRAC: Regularized Dirac type emission around prefered direction of emission.

The preferred direction of emission is defined by the impact angle of the primary sources and the 
point's normal. It is calculated assuming the specular reflection of ions. It is also averaged by 
primary source flux directions from all possible impacts of the primary sources.

These secondary sources can be selected with the command argument SECSOURCE in the IONMILL
command:

IONMILL ........  secSource=<one of sources>

where <one of sources> is SHIFTED, LINEAR, and DIRAC. 

Note:  All these sources are properly normalized by the total secondary flux released. They are limited by the point's horizon, 
defined as above, so the source function's value for direction below the horizon are 0.  

• Added a new parameter to geometrical CMP. This parameter is called thickness. The thickness 
parameter can now be used to specify the CMP plane relative to the highest point of the structure. 
The thickness parameter is mutually exclusive with the z parameter, which determines the CMP 
plane in absolute coordinates. For example, GeometryCMP  thickness=1.0 will stop CMP at 1um 
below the highest point of the surface.

• Implemented a selective mode for geometrical CMP. Thereby, you can selectively apply the CMP 
process to a single material. For example:

GeometryCMP   material="oxide" z=1.0

• Added the parameter LASTDEPO=<Number> to the GEOMETRYETCH command. It allows you to 
easily and quickly remove sacrificial layers that have been deposited only for the sake of ion 
implantation or diffusion. The number provided through the LASTDEPO parameter determines how 
many layers will be removed (typically it will be 1). For example, GeometryEtch lastDepo=1
removes the last deposited layer.

• Together with deposition, a stress profile can now be assigned to the deposited layer. Either a 
pressure profile or the full stress tensor can be specified for the deposited layer. Using the 
parameter PRESSURE=<Value>, a constant pressure in N/cm2 can be assigned to the deposited 
layer. Using the parameters PRESSUREAVERAGE=<Value> and PRESSUREGRADIENT=<Value>, a 
linear pressure function f(z) can be assigned to the deposited layer. 

PRESSUREAVERAGE determines the average pressure within the deposited layer and 
PRESSUREGRADIENT the gradient of the pressure within the deposited layer. The unit  of 
PRESSUREAVERAGE is N/cm2 and of PRESSUREGRADIENT is N/cm3. 

Using the parameter STRESSXX=<Value>, a constant value for the XX component of the stress 
tensor in N/cm2 can be assigned to the deposited layer. Using the parameters 
STRESSXXAVERAGE=<Value> and STRESSXXGRADIENT=<Value>, a linear function f(z) for the 
XX component of the symmetric stress tensor can be assigned to the deposited layer. 
STRESSXXAVERAGE determines the average value of the XX component within the deposited layer. 
1-2 SILVACO, Inc.
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STRESSXXGRADIENT determines the gradient of the XX component of the stress tensor within the 
deposited layer. The unit of STRESSXXAVERAGE is N/cm2 and of STRESSXXGRADIENT is N/cm3. 

Similar command parameters are available for the other components of the symmetric stress 
tensor (for XY, XZ, YY, YZ, ZZ). For example: 

GeometryDepo  material="nitride" thickness=0.06 stressXX=1e6

GeometryDepo  material="nitride" thickness=0.10 \ 

              pressureAverage=1e6 pressureGradient=3e10

• Added a new feature for geometrical deposition. It is now possible to deposit a layer with a planar 
surface. Therefore, the boolean parameter PLANAR can be used together with one of the parameters 
COORD=<Value> or FROMTOP=<Value>.

The parameter COORD specifies the absolute z-coordinate of the planar surface while the parameter 
FROMTOP specifies the z-coordinate of the planar surface relative to the highest point of the 
structure. If the value provided through the parameter FROMTOP is positive, the planar surface will 
cover the whole structure. While for a negative value of the parameter FROMTOP, the planar surface 
will be below the highest surface point and will only fill trenches. For example:

GeometryDepo material="oxide"   planar fromTop=0.1

GeometryDepo material="nitride" planar coord=1.15

VICTORY Cell (New Product)
VICTORY PROCESS CELL is a fast, layout-driven 3D process simulator specifically designed for large 
structures. Simulation speed is derived from careful selection of process models suitable for devices, 
such as CMOS image sensors, TFT arrays, power devices, and other large geometry structures.

• Fast 3D process-modeling of etch, deposition, implantation, and diffusion.
• GDSII layout-driven.
• Accurate and fully multi-threaded 3D Monte Carlo implantation.
• Mesh algorithms optimized for large device structures
• Automated layout-driven mesh generation.
• User-controlled mesh placement.
• Easy-to-learn and user-friendly SUPREM-like syntax.
• Interface to 3D Device simulators ATLAS 3D and VICTORY DEVICE.

VICTORY Stress (New Product)
VICTORY STRESS is a generic 3D stress simulator designed to calculate stresses and mobility 
enhancement factors for any 3D structure using comprehensive material stress models, including the 
dependence of elasticity coefficients on crystal orientation.

• Generic 3D anisotropic stress simulation for crystalline silicon.
• Stress analysis can be performed over full device structure, accounting for all isotropic and 

anisotropic properties of the materials, boundaries and initial conditions.
• Simulation of thermal mismatch between materials.
• Estimate mobility enhancement factors.
• Account for intrinsic stress in deposited material layers.
• Hydrostatic stress model for capping layers.
• “Design of Experiments” with VWF can be used to analyze stress dependence on process 

parameters, such as gate length or thickness variations.
• Interface to 3D Device simulators ATLAS 3D and VICTORY DEVICE.
SILVACO, Inc. 1-3
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VICTORY Device (New Product)
VICTORY DEVICE is a general purpose 3D device simulator. A tetrahedral meshing engine is used for 
fast and accurate simulation of complex 3D geometries. VICTORY DEVICE performs DC, AC, and 
transient analysis for silicon-based semiconductor devices, binary, ternary, quaternary, and organic 
material-based devices.

•  Tetrahedral mesh for accurate 3D geometry representation.
• Advanced physical models with user-customizable material database for silicon, compound, and 

organic materials.
•  Stress-dependent mobility and bandgap models.
• Highly customizable physical models using the C-Interpreter or dynamically linked libraries.
• DC, AC, and transient analysis.
• Drift-diffusion and energy balance transport equations.
• Self-consistent simulation of self-heating effects including heat generation, heat flow, lattice 

heating, heat sinks, and temperature dependent material parameters.
•   Advanced multi-threaded numerical solver library.
•  ATLAS-compatible.

ATHENA
• Introduced ATHENA 1D–a one-dimension version of ATHENA.
• Added capability to use implant moments stored in the implant table files with TSUPREM4-tm 

format.
• Implemented stress-dependent diffusion model and doping dependency of material elastic 

characteristics 
• Implemented substrate orientation and rotation dependent elastic stress model and dopant-

dependent stress model.
• A support for encrypted command files has been introduced.
• Added POLY parameter to the IMPLANT statement. This is an experimental feature-MC Implant 

will consider polysilicon material as a polycrystalline with grains predominantly oriented into 
{110} direction.

• Implemented dopant-dependent stress simulation capability.

ATLAS
• Added a way to define the location of an interface on the commands INTERFACE, INTTRAP, 

INTDEFECTS, and OINTDEFECTS.  The location can be specified as the interface between two sets of 
regions.  The regions can be specified by defining their number, their name, and/or their material. 

• Added the parameter DSTEP to the SOLVE statement. This parameter when set specifies the 
number of steps per decade for the case of current multiplication as specified by the IMULT
parameter.  

• Added the parameter INSULATOR to the MATERIAL statement. This specifies that a semiconductor 
region is to be treated as an insulator.

• Enabled support for 64-bit addressing on Solaris machines.
• Implemented defect generation model for amphoteric defects. This model calculates the dangling 

bond density of amphoteric defects as a function of bias stress time. 
• Added parameters ICDE.ELEC and ICDE.HOLE to the METHOD statement. When used in 

conjunction with the OXIDECHARGING statement (REM module), they couple the differential 
equations for trap occupation to the other variables and solve self-consistently.  Otherwise the trap 
occupations are updated through an integration after the end of each time step as previously.

• Finished implementation of writing drift and diffusion current components to the structure file.
1-4 SILVACO, Inc.
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• Improved the mesh generation algorithm for general quadrilateral region shapes.
• Modified the LOG statement so that if only INPORT or OUTPORT is specified, then the one-port Y-

parameters and Z-parameters can be saved to the log file.
• Added the capability to add analytic doping profiles along interfaces. 
• Improved the algorithm for flowline calculation. 

* Added the parameters CINT.PARAM, CINT.CHAR, CINT.INT, and CINT.DOUBLE to the OPTIONS
statement. The parameters can be used to create a C-Interpreter global parameter that can be 
accessed in any subsequent C-Interpreter function by calling the functions: 

• get_global_char()

• get_global_int() 

• get_global_double()

• Improved the parsing of files read in with the GRIDFILE.ISE and DATAFILE.ISE commands.
• Changed PROBE INTEGRATE so that it makes no special provisions for logarithmic quantities.
• Added the capability that switches the behavior of solutions carried forward after a simulation 

exceeds the maximum number of traps set by MAXTRAPS.  The parameter FAIL.SAFE of the 
METHOD statement when true (default) will exit the SOLVE statement with the mesh and 
electrodes reset to the solution at the last successful step.  If FAIL.SAFE is false, the simulator will 
exit the SOLVE statement with the results after the last applied Newton correction on the last 
failed step.  This may be useful in localizing an erronious condition.

• Added three new convenience functions.  These convenience functions work much like compliance. 
The functions enabled by the SOLVE statement parameters MONOTONIC, POSITIVE, and NEGATIVE
insure that the current on a defined electrode remains monotonic, positive, or negative.  If this case 
is not upheld during a voltage ramp, the simulator will exit the solve ramp at the point where the 
monotonicity, positiveness or negativeness are not maintained.

• Changed the default value of ZIP.SOLVER in the MIXEDMODE .OPTIONS statement to be true 
for ATLAS3D.

• Added the parameters PRECONDIT, FILL.LEVEL, and FILL.RATIO to the METHOD statement. 
These parameters control the preconditioner used by the ZIP.BICGST iterative solver. 
PRECONDIT=0 uses the ILU preconditioner (default), 1 is ILUK, and 2 is ILUP. If PRECONDIT=1, 
then FILL.LEVEL can be used to set the fill level for the ILUK preconditioner (default = 0). If 
PRECONDIT=2, then FILL.RATIO can be used to set the fill ratio for the ILUP preconditioner 
(default =0.5).

• Implemented dynamic library version of the ZIP iterative solvers. 
• Modified DOSEXTRACT so that EXTRACT or TONYPLOT User Data format can be used for the IV and 

CV data files.
• Added DOSEXTRACT statement to ATLAS. This statement allows the grain boundary and interface 

trap density of states as a function of energy to be extracted from IV and CV files (see ref [1]) and 
saved to log files.

• Modified FILE.LID on the MODELS statement so it will use the amphoteric file coordinates as 
specified on the DEFECTS statement when saving the dangling bond density of states file.

• Added default permittivities for ZnO and SnTe.
• Added periodice boundaries for finite difference analysis. 
• Modified ATLAS3D so that the maximum number of XY plane nodes is increased to 100,000.
• Corrected an internal scaling problem with CDL.COUPLING and added a check to see if the value of 

CDL.COUPLING input is not too large for the parser. 
• Increased the log file precision to 16 decimal places for the small-signal AC parameters.
• Enabled the bounding box defined by LEFT, RIGHT, TOP, BOTTOM, FRONT, and BACK on the PROBE

statement for vector quantities.
• Made the Fowler-Nordheim model localizable (FNORD, FNHOLES, FNPP, and FNHPP). 
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• Added the parameter SPEEDS to the METHOD statement. If this parameter is specified, then the 
SPEEDS direct linear solver will be used in ATLAS3D instead of the DIRECT, CGS, BICGST, or 
ZIP.BICGST solvers.

• Modified ATLAS3D so that the internal voltage is displayed in the run-time output for 
CURVETRACE.

• Extended support for general quadrilateral shapes for region boundaries specified on the REGION
statement to more than one quadrilateral.  

• Added the parameter SPEEDS to the METHOD statement. If this parameter is specified, then the 
SPEEDS direct linear solver will be used in ATLAS instead of the DIRECT solver. 

• Changed the maximum number of characters allowed in filenames to 132.
• Added new defaults for Eg, chi, epsilon, Nc, Nv, mun, and mup for CIGS, CdS, and ZnO.
• Added SnO2 material.
• Changed polarization charge so that it can apply to insulators that were changed over from 

semiconductors. This allows wide bandgap semiconductor buffer layers to be handled as insulators.
• Added the new materials InAlN, In2O3, and TiO.
• Added the permitivity and thermal conductivity of SnO2.
• Added periodic boundaries for ATHENA generated structures.
• Added support for token bundle licensing.
• Modified the GMRES parameter on the METHOD statement so that it uses the AMS solver with a 

single level preconditioner. If this parameter is specified, then the GMRES iterative linear solver 
will be used in ATLAS3D instead of the CGS solver.

• Added the parameter AMS to the METHOD statement. If this parameter is specified, then the AMS 
iterative linear solver will be used in ATLAS3D instead of the CGS solver. This is a GMRES-type 
solver with a multilevel preconditioner.

• Added the parameter USER.GROUP to the REGION statement. USER.GROUP is used to specify the 
group for the user material as either SEMICONDUCTOR, INSULATOR, or CONDUCTOR.  The default 
value is SEMICONDUCTOR.

• Added thermal velocities to MODELS PRINT output.
• Enabled MULTICORE module for TCAD OMNI license.
• Added ALUMINUM to the list of allowed silicon acceptor dopants. The parameter ALUMINUM on the 

DOPING statement can now be used to specify acceptor doping and aluminum doping is now 
recognized in structure files.

• Added the parameter MIDGAP to the TRAP and INTTRAP statements. If this parameter is specified, 
then the trap energy level is set to the middle of the bandgap.

• Modified ATLAS3D so that the GMRES solver gives improved performance when used with the 
HALFIMPLICIT method.

• Implemented the first version of parabolic strain dependent zincblende gain and radiative 
recombination k·p model. 

• Implemented the InP lattice matching condition into the strained zincblende ZB.KP model.
• Added a model for the increase in electron recombination lifetime, which has been observed in LT-

GaAs at high fields. 
• Implemented C-Interpreter functions for electron and hole impact ionization coefficients.
• Modified the structure file saving and loading so that CONDUCTOR regions can be loaded back 

without specifying CONDUCTOR on the MESH statement.
• Added a model to simulate hysteresis effects on interface traps at a semiconductor-insulator 

interface. It applies to steady-state bias ramps and a measurement time must be specified by using 
the TIMESPAN parameter on the SOLVE statement. 

• Added to ability to visualize separately the electron and hole trap recombination rates for 
transient traps.
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• Modified the METHOD statement so that the QUASI time step algorithm can be used with the non-
second order transient discretization scheme.

• Added the parameter RATIO.TIME to the METHOD statement. This parameter specifies the 
minimum time step ratio allowed in transient simulations. If the calculated time step divided by 
the previous time step is less than RATIO.TIME, ATLAS will cut back the transient solution 
instead of continuing on to the next time point.

• Extended the NIT.N and NIT.P functionality to allow you to specify spatial limits for the assigned 
charge densities.  

• Added the capability to output electrode hot electron and hot hole currents separately to log files.
• Implemented 1st order backward difference formula (BDF1) transient
• Removed the Net Doping check for structure files that modified the donor and acceptor 

concentrations for a DEVEDIT or DEVEDIT3D structure file.
• Modified the V<n>, I<n>, Q<n>, and T<n> parameters on the SOLVE statement so that they 

support electrodes 51 to 200.
• Expanded the translation of TIF files to handle the situation where a metal region and an 

electrode are independently defined over the same region.
• Added support for encrypted input decks. 
• Implemented current boundaries with contact resistance.
• Modified non-local Band-To-Band tunnelling (MODELS BBT.NONLOCAL) so that it works correctly 

with a CYLINDRICAL mesh.
• Modified MESH INFILE structure loading so that the "Trapped Insulator e- Concentration" and 

the "Trapped Insulator h+ Concentration" loaded by default.
• Put in non-zero electron affinities for 6H-SiC, 4H-SiC and 3C-SiC.
• Added support for Tungsten Silicide, Titanium Silicide, Nickel Silicide, Cobalt Silicide, Tantulum 

Silicide, Palladium Silicide, Platinum Silicide, Molybdenum Silicide, Zirconium Silicide, and 
Aluminium Silicide materials in TIF files.

• Added support for the "ATLAS_P" environment variable. This specifies the number of threads 
CPUs to be used.

• Added special ohmic boundary conditions that set the n-concentration to Nc (NOHMIC on the 
CONTACT statement) and p-concentration to Nv (POHMIC on the CONTACT statement).

• Added some more general purpose doping functions that are more analogous to those provided by 
DEVEDIT.  As usual for analytic profiles, a uniform concentration specified by PEAK or CONC is 
defined within the limits defined by X.MIN, X.MAX, Y.MIN, Y.MAX, Z.MIN, and Z.MAX.  At the 
edges of this box, you can specify either a Gaussian or error function fall-off using X.GAUS, 
Y.GAUS, Z.GAUS, or X.ERF, Y.ERF, and Z.ERF for each of the principal directions.  The rapidity of 
the fall-off is defined by X.CHAR, Y.CHAR, and Z.CHAR similar to the CHARACTERISTIC 
parameter.  Alternatively, the junction location relative to the box edges can be specified by X.JUN, 
Y.JUN, and Z.JUN.  Here, the parameter defined the distance from the edge where the junction is 
located rather than the absolute location of the junction.  Negative values find the junction relative 
to the MIN coordinates.  The location where the junction is found for the normal coordinates is 
given by X.SLI, Y.SLI, and Z.SLI.

•  Added a filtering function for doping.  This function looks for areas where contiguous mesh points 
of the same doping type are completely surrounded by mesh of the oppostite type without 
contacting to an electrical contact.  These "floating islands" of doping are removed by reassigning 
their majority concentration to half of the local minority concentration effectively changing their 
type to the surrounding type.  At the same time, the locations and doping information for each 
point modified is printed out.  

• Fixed transfer matrix in 2D Luminous so that cases with available photocurrent larger than source 
photocurrent are eliminated.

• Enabled TR.MATRIX for spectral response (i.e., SOLVE LAMBDA=) simulation.
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• Added ANGLE to the SOLVE statement.  This angle is added to the ANGLE in the BEAM statement to 
allow angular analysis.  The angle also written to the log file and run time output.  A re-evaluation 
of the photogeneration rate is done for each change in angle.

• Added periodic boundarys to FDTD optical sources.  This is enabled by the PERIODIC parameter of 
the BEAM statement.

• Changed the source boundary condition for plane sources from a hard source (one with reflection of 
scattered field) to a TFSF (transmitted field scattered field) type boundary that allows scattered 
waves to pass throught the source.  

• Changed F.RADIATE function prototype to be 
int radiate(double x,double y,double z,double t,double *rat);

• Changed the frequency of outputting VERBOSE run-time output for FDTD.  It now only outputs 
updates every 5 seconds.  This also improves the estimated time to complete.

• Added the parameter TD.SRATE to the BEAM statement. This parameter expresses the spatial 
sampling rate in number of samples per wavelength for FDTD. 

• Added a parameter called DT.SAFE to FDTD that automatically enforces the CFL limit to the time 
step if true.

• Added reflection, absorption, and transmission coefficients to  log file.
• Added parameters NK.NM and NK.EV on the MATERIAL statement to change the default 

wavelength/energy parameter units to nanometers or elevtron volts respectively. 
• Added INDX.REAL and INDX.IMAG parameters to the MATERIAL statement for inputting real and 

imaginary components of complex index of refraction from independent files.
• Changed FDTD so that it remeshes for each wavelength in multispectral simulations.
• Made it so that if the beam origin is not specified for ray tracing or transfer matrix method, the 

beam will automatically be placed above the device in the negative y direction and will be directed 
in the positive y direction.

• Added the OUTLOGS parameter to the OPTIONS statement to automatically output all complex 
index and optical beam spectra to disk in log file format.

• Added the capability to use two default solar spectra obtained from a government web site by 
specifying either AM0 or AM1.5 on the BEAM statement.

• Made SOPRA database complex index of refraction data the material dependent default for most 
corresponding materials when not otherwise defined.

• Added complex index default data for CdS.
• Added new LENS statement.  This allows application of multiple lenselets. All LENS statements 

following a BEAM statement will apply to the last defined beam.  The type of lenslet is specified by 
the FLAT, SPHERIC, ELLIPSE, COMPOSITE, ASPHERIC, and PYRAMID logical parameters of the 
LENS statement.

• Added capability to read in complex index of refraction with units of energy rather than 
wavelength. 

• Added default complex indices of refraction for CIGS.
• Added the SOLAR statement to enable simple conveniences for solar analysis.  The IV parameter 

may be set to a file name for solar IV analysis and extraction of Voc, Isc, Pmax, and FF.  A voltage 
ramp is automatically performed and results of the voltage ramp are stored in the named file. The 
ANODE parameter should be set to the index of the positively biased electrode.  If the parameter is 
unspecified, the code will automatically seek the electrode named "anode".  The BEAM parameter 
should be set to the index of a beam for this analysis.  The beginning step size for the sweep is 
specified by the DV parameter with a default of 0.05 volts.  The resolution at Voc is given by the 
MIN.DV parameter with a default value of 0.002 volts.

• Added the capability to ramp the angle of propogation or wavelength of an optical source in a 
single solve statement. 

• Added the capability to output time domain Z plane slices during simulations of FDTD in 3D.
• Added the capability to ignore Z or X dependence in lenses in FDTD 3D. 
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• Added complex index of refraction to time domain snapshot structures in FDTD 2D and 3D.
• Added the parameters FILE.PHOTOGEN, DX.PHOTOGEN, DY.PHOTOGEN, X0.PHOTOGEN, and 

Y0.PHOTOGEN to the BEAM statement. These parameters allow a file specified by FILE.PHOTOGEN
containing the photogeneration rate to be imported into LUMINOUS. DX.PHOTOGEN and 
DY.PHOTOGEN specify the x and y spacing between each value in the file and must be specified 
along with FILE.PHOTOGEN. X0.PHOTOGEN and Y0.PHOTOGEN specify the top left origin of the 
photogeneration. If X0.PHOTOGEN and Y0.PHOTOGEN parameters are not specified, then the top 
left point of the device is used for the origin.

• Changed the solar efficiency calculation on the SOLAR statement to be expressed as the IV product 
divided by the intensity in the input spectrum for angle and wavelength ramps.

• Improved runtime output for multispectral sources to include the intensity in the input spectrum 
as well as the subsampled spectrum.

• Changed the optical intensity output to log files for multispectral sources to represent the 
integrated spectrum of the input file as defined by POWER.FILE, AM0, or AM1.5 parameters of the 
BEAM statement.

• Added Lambertian, triangular, and ellipitical angular distribution functions to the diffusive 
interfaces. 

• Enabled the use of anti-reflective coatings in the transfer matrix method.
• Added the complex indices of refraction on either side of the interface to the arguments for the C 

interpreter function F.REFLECT on the BEAM statement.
• Added the capability to plot optical intensity for TMM analysis as the magnitude square of the 

optical field.
• Added a version of transfer matrix method with diffusive interfaces.
• Added complex index default data versus wavelength for ZnO and SnO2.
• Added complex index data for SnTe.
• Changed the angular units for the C-interpreter function F.REFLECT in the template.lib to 

radians.
• Added region boundaries to FDTD output structure file snapshots.
• Added the capability to probe the subsampled optical intensity for multispectral sources in 

LUMINOUS.
• Added the Rajkanan model for strain dependent silicon absorption  coefficient.
• Modified Rajkanan strain dependent absorption model to only apply strain induced band edge 

changes to narrowest indirect band gap.
• Added capability to define complex index of refraction using absorption coefficient.
• Changed reading of angular distribution function table to angle in degrees.
• Added ability to input the angular distribution function from tabular data.  
• Added ability to input CT and CR factors of the haze functions from tabular data. 
• Added incidence angle to the computation of haze functions.
• Added the capability to output haze factor plots. 
• Implemented plotting of lens edges in FDTD snapshots.
• Improved run time output for FDTD.
• Added windowed sources for FDTD.
• Made a change to the SOLAR statement so it works properly with WIDTH set on the MESH statement.
• Changed FDTD snapshots output by TD.FILE to have coordinates in the device frame rather than 

relative to the beam origin.
• Added capability to force a reflection coefficient at an interface for ray trace in LUMINOUS. 
• Implemented frequency conversion materials in LUMINOUS 2D.
• Introduced the Tauc-Lorentz-Urbach dielectric model for complex index of refraction. 
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• Introduced a flag DIEL.FUNC to the BEAM statement that plots out the dielectric function for the 
Tauc-Lorentz model instead of complex index of refraction for calibration purposes.

• Introduced the capability to plot out the analytic complex index models. 
• Added the ability to shift complex index of refraction data input from data files in energy. 
• Extended the capability to extract DOS information from imaginary index data to tabular data.
• Added the capability to plot midgap density of states estimated from the absorption coefficient 

while plotting the complex index and absorption coefficient as specified by the OUT.INDEX
parameter of the MATERIAL statement.

• Added the capability to plot complex index and absorption using energy as the ordinate.
• Added the capability to plot absorption coefficient with complex index to the file specified by 

OUT.INDEX on the MATERIAL statement.
• Enabled parallel processing for ray tracing in LUMINOUS3D and LUMINOUS2D.
• Added probe in FDTD 2D for LUMINOUS.INTENSITY and PHOTOGENERATION.
• Changed the definitions of reflectivity and transmission for ray trace.  Reflectivity is defined as the 

integral of the intensity of all rays internally or externally reflecting from the device in a direction 
within a half sphere of the direction toward the source. Transmission is defined as the integral of 
the intensity of all rays exiting the device in a direction within a half sphere of the direction of 
propagation of the source.

• Added photogeneration rate to the structure files output using TD.FILE in FDTD.
• Extended the use of frequency conversion materials to FDTD and TMM modeled primary sources.
• Added negative lenses to LUMINOUS.
• Implemented a C interpreter function F.IMAGE that allows specification of intensity scaling as a 

function of X and Z in LUMINOUS 3D ray trace.
• Added energy to complex index of refraction output using OUT.INDEX on the MATERIAL statement.
• Added parameter CON.REFLECT to the BEAM statement.  This acts exactly like the 

METAL.RELFECT parameter except for regions defined as CONDUCTOR on the REGION startement.
• Added probing layer reflectivity, transmission and absorption to ray trace.
• Added MATERIAL statement to PML and LENS statements to allow material specific defaults and 

user specified indexes using the MATERIAL statement.  This is especially important for the PML so 
index can be matched over wavelength.

• Changed diffusive transfer matrix method to model transmissive haze function using 
|n1*cos(theta1)-n2*cos(theta2)| rather than the previous expression cos(theta)*|n1-n2|.

• Enabled lenslets in 2D ray tracing.
• Added user-definable lenslet using C-interpreter.
• Implemented random 3D lenslets.
• Added AR coatings on lenslets for 2D ray tracing.
• Added parameter TWODEE on the LENS statement to specify 2D lenslets (having no z variation) in 

three dimensional ray trace or FDTD.
• Added the capability to display lenslets with 2D and 3D ray trace.
• Added C interpreter function to define LASER transverse mode.
• Removed a limitation on the number of eigenvalues used in Schrodinger equation when parameter 

EIGEN is not specified on the MODELS statement.
• Added an option to output eigenvalues of Helmholtz solver (propagation constant beta) to a 

separate log file. 
• Added R.HELM and I.HELM to the PROBE statement for probing real and imaginary part of the 

propagation constant beta as obtained by Helmholtz eigenvalue solver in the LASER module.  
• Added a new capability of computing photonic modes and dispersion of dielectric waveguides by 

solving 2D vector Helmholtz equation.
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• Added parameters to control and check iterative eigensolver for vector Helmholtz on the 
WAVEGUIDE statement. 

• Corrected output intensity pattern for WAVEGUIDE using vector Helmholtz solver.
• Implemented REFLECT parameter for vector Helmholtz solver on WAVEGUIDE statement to model 

symmetric structures. 
• Added an option for output of far-field and near-field patterns in WAVEGUIDE, which uses vector 

Helmholtz. 
• Added a GAINMOD parameter to LASER statement. 
• Added a new version of LASER module, which uses vector Helmholtz solver.  The new model also 

utilizes fully coupled Newton method for solving photon-rate, drift-diffusion, and Poisson 
equations. 

• Added new parameters to LASER statement for the new version of LASER with vector Helmholtz. 
• Modified LASER functionality, so that lasing frequency does not change from bias to bias or from 

iteration to iteration. Allowing lasing frequency to float may cause poor LASER convergence, 
however fixing the lasing frequency requires you to set lasing frequency manually in the input 
deck. 

• Modified vector Helmholtz solver so that it can include metals or other materials with negative 
real part of dielectric constants into the solution domain.

• Added an option to output square of optical fields obtained by vector Helmholtz in LASER and 
WAVEGUIDE:  |Ex|2,|Ey|2,|Ez|2,|Hx|2,|Hy|2,|Hz|2.  

• Fixed far-field pattern generation in Laser with vector Helmholtz.
• Fixed laser mesh, so that it can be limited by XMIN, XMAX, YMIN, and YMAX on the LASER statement. 
• Added and option to store Total modal Loss in the log IV file of LASER.  
• Added functionality for user-defined optical dielectric constants EPS.XX, EPS.YY, and EPS.ZZ

parameters on the MATERIAL statement, which are used in vector Helmholtz. These parameters 
will overwrite the optical dielectric constant of the  material only if specified. If they are not 
specified, isotropic dielectric constant will be defined by for example REAL.INDEX  and 
IMAG.INDEX parameters, or using interpreter function, or user input file or using a default 
database. Additionally, you can overwrite imaginary part of dielctric constant using EPSIM.XX, 
EPSIM.YY, and EPSIM.ZZ  on the MATERIAL statement. Also, parameters EPS.ISO and 
EPSIM.ISO can be used to define isotropic dielectric constant.

• Extended all Schrodinger, NEGF, and DDMS (drift-diffusion in the mode space) solvers to handle 
both electrons and holes simultaneously. 

• Coupled ATLAS mobility models to  mode-space drift-diffusion model (DDMS) in ATLAS 2D and 
3D. 

• Coupled Atlas impact ionization models to mode-space drift-diffusion (DDMS) method in 
ATLAS2D and ATLAS3D. 

• Added an internal iterative procedure for DDMS, which iterates between carrier densities and G-R 
rates before plugging electron density into Poisson. 

• Added Schottky barrier contact model to DDMS model. 
• Fixed a bug which cased divergence of BQP in the case of very high doping. 
• Added recombination rates to DDMS model (mode-space drift diffusion).
• Changed  parameters BND.ENER and WAVE.FUN on PROBE statement to new parameters 

NBND.ENER, NWAVE.FUN, PBND.ENER, and PWAVE.FUN, which correspond to  probes of electron and 
hole bound energies and wave functions.

• Modified calculation of R-G rates in the case when Schrodinger is used as a postprocessing to a 
regular ATLAS solution (MODELS schro and METHOD carriers=2).  A quantum carrier density 
will be used instead of classical.

• Added an option SP.GEOM=2DXY for Schrodinger solver in the case of cylindrical coordinates in 
ATLAS2D.  This corresponds to 3D confinement in the radial, axial, and orbital directions as it 
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occurs in a cylindrical quantum dot. The method works on rectangular original mesh or 
rectangular SP mesh on top of original non-ATLAS mesh.

• Added an option SP.GEOM=1DY for Schrodinger solver in the case of cylindrical coordinates in 
ATLAS2D.  This  corresponds to 1D confinement along the axis of a cylinder as it occurs in a 
VCSEL.

• In DDMS method, added an option to store subband-related quantities in separate log file: eigen 
energies, carrier densities, currents, quasi-fermi levels and total generation-recombination rates in 
each sub-band. 

• Extended Schrodinger-Poisson -based optical gain model on the case of rectangular SP mesh, 
specified on top of original mesh (rectangular or non-rectangular).

• Added parameters to stop possible oscillatory convergence in Schrodinger-Poisson loop iterations 
and to limit maximum number of iterations. 

• Added a quantum well gain model based on Schrodinger-Poisson for 1D Schrodinger and 
ATLAS2D.  The model has similar functionality to QWELL model (such as computes gain, 
spontaneous emission spectra, LUMINOUS intensity vs. bias) but computes electron density self-
consistently and allows coupling between wells.  The computation combines solution of classical 
transport equations, and then using classical quasi-fermi levels to find quantum electron density 
self-consistently with Poisson. After that, optical quantities are computed and stored in the output 
files. This model does not give any feedback of optical recombination into transport equations (this 
option will be made in future).

• Changed QTREGION statement so that it creates an extra mesh in order to do interpolation on, 
rather than modifying the existing mesh.

• Added a model for calculating the direct tunnelling current through Metal-Insulator-Metal 
capacitors. The materials contacting the electrodes must be insulators or insulators which have 
been changed to wide bandgap semiconductors using the SEMICONDUCTOR parameter on the 
MATERIAL statement. The current is simply the purely tunnelling current though the potential 
barrier caused by the insulator stack, and is added to the output currents.

• Added a parameter DTPP to the MODELS statement.  When specified along with DT.CUR, it causes 
the post-processing version of the Medici Direct Tunnelling method to be enabled. 

• Added an option to feedback a radiative recombination obtained by Schrodinger-Poisson based gain 
model into classical transport equations in ATLAS2D. 

• Added Schottky barrier contact model to NEGF model. 
• Enabled CONDUCTORS when used with BQP in BLOCK method in 2D and 3D.
• Updated multiband and QWELL models and coupled them to LASER with vector Helmholtz. 

Different multiband models can be specified in different regions. The output structure file will 
contain conduction and valence bands for each band.  

• Corrected the calculation of the Quasi-Fermi levels with the Density Gradient model enabled.
• Added parameter WELL.DENERGY on MODELS and MATERIAL statement, which is synonymous to 

already existing WELL.DE on MATERIAL. The parameter sets an energy spacing for integration of 
quantum well spectrum to obtain spontaneous emission recombination, which is plugged in 
continuity equations.

• Added parameter WELL.MARGIN on the MODELS to set the maximum penetration depth of quantum 
well wavefunctions into the barrier. 

• Added an option to specify orientation of quantization in QWELL model. Use old parameter 
SP.GEOM={1DX, 1DY, or 1DZ} on the MODELS statement to set the quantization direction. Different 
quantum wells can have different orientation of quantization direction.

• Changed the default value of ESIZEOUT.NEGF parameter on the OUTPUT statement: if the 
parameter is not set, it will be the same as ESIZE.NEGF parameter on the MODELS statement.

• Implemented a planar NEGF solver to model Resonant Tunneling Diodes and other planar 
structures. The model is based on a solution of 1D Non-equilibrium Greens Function (NEGF) 
equations within effective mass approximation, solved self-consistently with Poisson. No transport 
in perpendicular direction is allowed.  
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• Fixed user-defined band off-sets for Schrodinger, NEGF and DDMS solvers and added the option to 
input these parameters from MATERIAL and MODELS statement in addition to REGION statement. 

• Changed the SRH and CONSRH models to use a modified intrinsic carrier concentration when 
solving the BQP equations.

• Corrected QWELL gain for old laser for a case of longitudinal modes, which caused problem in 
laserex05.in.

• Modified variable names of Bound State Energy and Wave Function in Quantum module. The 
words "Longitudinal" , "Transverse1", and "Transverse2" are changed to "valley 1", "valley 2", and 
"valley 3" to refer to different valleys of conduction band.

• Improved internal mesh in QWELL model for better convergence.
• Extended quantum tunneling with schrodinger model to handle both electrons and holes.
• Added the SIS.TAT model. This is intended for use with structures containing an insulating layer 

between two semiconductors. It will also work for heterostructure barriers.  It is similar to the 
existing trap assisted tunnelling models, but uses a non-local SRH model to transfer charge across 
the insulator.  

• Modified the TAT.NONLOCAL model to handle heterojunctions.  The default trap level is changed 
from being the Midgap to being the intrinsic Fermi level.

• Removed the restriction of CARR=1 on the new SIS.EL and SIS.HO models for S-I-S tunneling. 
• Removed the restriction of CARR=1 on the new FNORD and FNHOLES models for S-I-S tunneling. 
• Extended the FNORD and FNHOLES models to tunneling through insulator layers that are 

between two semiconducting regions. The functionality for tunneling through insulators that are 
directly adjacent to contacts is unchanged. 

• Added a tunnelling model for calculating direct quantum tunneling from a semiconducting region 
through insulating regions to another semiconducting region. 

• Added functionality to model SONOS devices.
• Enabled Lucky electron charging models for SONOS structures.
• Made some improvements to BBT.NONLOCAL implementation.
• Improved convergence of SONOS model and enabled HEI/HHI models for use with DYNASONOS 

version of SONOS model.  
• Added a model to simulate the steady-state I-V characteristics in Silicon Nitride. The model 

simulates the Poole-Frenkel behaviour of the Nitride mobility by including an extra electron 
generation term which is proportional to the difference between the fixed nitride charge and the 
free electron charge at each point.

• Enabled the CONCANNON hot carrier injection model for use with DYNASONOS. 
• The rates of electron and hole generation in the Nitride due to tunneling and carrier injection are 

output to the structure file as are the net rates of carrier transfer between the band edges and the 
trap states.

• A Poole-Frenkel model for the trap emission rates in the SONOS model has been added. 
• Added the capability to PROBE the net value of trapped Nitride charge (trapped electrons–trapped 

holes). 
• Changed the way direct tunnelling gate current is output in the DYNASONOS model. It is now 

output as an explicit tunnelling current rather than just being added to the total current. 
• Added the ability to SOLVE the Poisson equation with the trapped insulator charge (in Silicon 

Nitride) set to a specified fixed density.
• Added the parameter SONOS to the SOLVE statement which works with SOLVE INIT and the 

DYNASONOS model. It freezes the carrier concentrations in the gate insulator stack to avoid 
spurious free carrier concentrations occuring when there is a large concentration of trapped charge 
in the Nitride. 
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• Added the parameter SONOS.CURR to the LOG statement.  If enabled when the SONOS model is 
being used it causes the channel to Nitride and Nitride to contact tunnelling currents to be printed 
to the log file.

• Made a change to the statistical factor used in the BBT.NONLOCAL model, which takes into 
account the restrictions on the values of transverse wavevector.  This will have most effect when 
the energy range for the Band-To-Band processes is relatively small. 

• Added ability to cut back bias to BBT.NONLOCAL model if it generates unphysical solutions during 
a bias ramp.

• Added the ability to output the Gamma factors in the TAT.NONLOCAL model to a structure file. To 
use this, you specify NLTAT.GAMMA on the OUTPUT statement.

• Changed the implementation of TAT.NONLOCAL so that it works with a mesh defined by QTREGION
statements as well as the QTX.MESH/QTY.MESH statements.

• Added direct trap-to-channel tunnelling to the SONOS model.
• Improved the interpolation of band energy profiles when the QTUNN and related models are being 

used. This reduces the interpolation error arising at interfaces and means that tunneling 
insulators may contain fewer mesh points in the tunnelling direction.

• Added Band-Engineered SONOS model. This is an extension to the DYNASONOS model which 
allows the tunnel insulator to be made up of several insulating layers. Because a thin layer of 
Silicon Nitride may be used as one of these layers,  the model requires that Silicon Nitride regions 
to be used as charge trapping layers be specified explicitly as such. 

• Added a hot carrier gate current model to be used with DYNASONOS model. It self-consistently 
couples the hot carrier currents to the continuity equations in the Silicon Nitride layer.  

• Modified the calculation of insulator tunnelling current when either Bohm quantum potential or 
Density gradient models are enabled. The new implementation does not allow any tunneling to 
occur at energies below the ground state energy of any potential notch at the interface. If the 
potential is non-confining then there is no change.

• Improved the HOTSONOS model to prevent spurious densities occuring and enabled HOTSONOS 
for use with DEVDEG model.

• Changed the time propagation algorithm for trapped nitride carrier densities in the DYNASONOS 
model.

• Added visualisation of the tunnelling current produced by the Direct Quantum Tunneling models. 
The tunnelling current associated with each interface node is output to any structure files that are 
saved.  

• Changed the carrier concentration interpolation scheme used in MAGNETIC3D form log-linear to 
Scharfetter-Gummel.

• Implemented new algorithm for MAGNETIC2D and improved MAGNETIC3D.
• Applied a new discretization for galvanic transport to MAGNETIC3D. This maintains current 

continuity, unlike the existing one, but is only applicable to structures comprising right angled 
prisms.  For any non-right angled prisms, the old discretization is used, which will degrade current 
continuity.

• Added the ability to correctly handle Fermi-Dirac carrier statistics to the new MAGNETIC3D 
discretisation.

• Improved the convergence behavior of MAGNETIC3D when used with Field dependent mobility 
models, such as FLDMOB and CVT.  Also improved the current continuity in some cases.

• Introduced the parameter aliases R.ELEC for RH.ELEC and R.HOLE for RH.HOLE.  These are the 
Hall scattering factors for electrons and holes respectively. 

• Added Monte Carlo device simulator module (MCDEVICE) to ATLAS. 
• Modified BLAZE so that it supports silicon based materials. 
• Introduced an anisotropic impact ionization rate model suitable for simulation of 4H SiC.  
• Put piezoelectric charge calculation for GaN into 3D.
• Added interpolation of GANSAT parameters for InAlN and InAlGaN.
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• Added a check so that if the GANSAT mobility model is used for a material where the defaults are 
not available, ATLAS will print an error and exit.

• Added a parameter DTUPDATE to the METHOD statement that specifies the temperature change in K 
that initiates recalculation of temperature only dependent models, such as composition dependent 
mobility and bandgap. 

• Introduced mobility derivatives into Jacobian for Joule heat flux in block and Gummel methods.
• Added a parameter CLIM.LAT for the minimum resolvable carrier concentration for Joule heating 

calculation.
• Reworked the derivatives for the Albrecht and FMCT mobility models to improve convergence for 

heatflow simulations in GaN.
• Modified THERMCONTACT so that the thermal contact number will be automatically assigned if 

NUMBER is not specified.
• Added Heat Capacity and Heat Conductivity to the structure file.
• Fixed a scaling error with the GR.HEAT parameter in GIGA. 
• Put in interpolation of thermal coefficient models between the binaries for InGaN AlGaN InAlN 

and InAlGaN.
• Expanded the Thermal Parameters section of "models print" so that the coefficients for the 

TCON.POWER, TCON.RECIP, and HC.COMP models are displayed.
• Changed the structure file output of lattice temperature so that heat flow parameters are not 

output unless heat flow analysis is enabled by LAT.TEMP on the MODELS statement.
• Made a correction to the extra heating term which arises when using the HEAT.FULL option in 

GIGA in transient mode.  It is now consistent with the reference work for this model. 
• Added the constant zero as the thermal conductivity default for the materials "vacuum".
• Added support for .GLOBAL statement in MIXEDMODE. 
• Added the parameter R=tval to the PWL parameter definition in MIXEDMODE for voltage, current, 

and optical sources. This specifies the time point from which the PWL waveform should be 
repeated. The section of the waveform between tval and the end of the PWL will be repeated until 
the transient analysis is completed.

• Added transient parameters to the capacitor and inductor MIXEDMODE elements.
• Added the parameter R=tval to the TABLE parameter definition in MIXEDMODE for voltage, 

current, and optical sources.  
• Added the parameter R=tval to the PWLFILE parameter definition in MixedMode for voltage, 

current, and optical sources. This specifies the time point from which the PWL waveform should be 
repeated. The section of the waveform between tval and the end of the PWL will be repeated until 
the transient analysis is completed.

• Modified MIXEDMODE so that the QFACTOR is cut back if the initial bias point fails to converge 
when the density gradient model is enabled.

• Modified MIXEDMODE so that voltage and current source DC values can be initialized by the first 
bias value in a PWL or a PWLFILE parameter.

• Modified MIXEDMODE so that the QFACTOR is cut back if the initial bias point fails to converge 
when the Bohm quantum potential model is enabled.

• Added the parameter DEVICE to the SINGLEEVENTUPSET statement. This specified which device 
the SINGLEEVENTUPSET statement applied to in MIXEDMODE.

• Added support for CONDUCTOR regions in structure files to MIXEDMODE and MIXEDMODE3D.
• Added support for the .LIB statement to MIXEDMODE and MIXEDMODE3D. This allows a library 

file, or a named section of a library file, to be included into the input deck. The syntax is:
.LIB filename entryname

where filename is the name of the file to be included, and entryname is a section of the library 
file starting with .LIB entryname and ending with .ENDL.
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• Added support for the .INCLUDE statement to MIXEDMODE and MIXEDMODE3D. This allows a file 
to be inserted into the input deck at the point when the statement appears. The syntax is:
.INCLUDE filename

where filename is the name of the file to be included. 

• Modified MIXEDMODE so that the latest version of ModelLib SPICE models are available. 
• Improved convergence of exciton dissociation and Poole-Frenkel mobility code.
• Added default values for Eg, chi, epsilon, Nc and Nv for pentacene.

• Added the organic materials: CuPc, NPD, CBP, Irppy and BAlq.
• Added exciton binding energies S.BINDING for singlets and T.BINDING for triplets to the 

MATERIAL statement. These are not yet used.
• Added exciton dissociation to the organic simulators for simulation of organic solar cells.  
• Added Koster (ref 1) modification to Langevin recombination model.
• Added dissociation rate and dissociation efficiency in structure file for organic solar simulation.
• Added dissociation rate, dissociation efficiency and Langevin recombination in the probe.  These 

are specified by the DISSOC.RATE, DISSOC.EFF, and RLANGEVIN parameters of the PROBE
statement.

• Changed the functionality of SOLVE L.WAVE so that LUMINOUS quantities are only printed out for 
regions for which the LED flag has been specified on an associated REGION statement.

• Added built in complex index of refraction data for Alq3, CIGS, ITO, and NPB.
• Made it so that the various LED log file writing routines that output LUMINOUS power or intensity 

can be overlain in TONYPLOT.
• Added comments to input user files defined by lines starting with "#".  This feature applies to files 

defined by INDEX.FILE, INDX.REAL, INDX.IMAG, USER.SPEC, and DOPE.SPEC on the MATERIAL
statement and USER.SPEC on the LED statement.

• Added OUT.USPEC and OUT.DSPEC to the MATERIAL statement (OUT.USPEC on the LED
statement) to allow output of TONYPLOT log file representations of user specifiable photo-
luminescence spectra.

• Changed LOG statement so that ANGPOWER need not be specified to extract data using SPECTRUM
parameter.

• Improved the speed of quantum well LED by optimizing integration of spontaneous emission 
spectrum, when SPONTANEOUS parameter is switched on the MODELS statement. 

• Modified functionality of LMIN, LMAX, EMIN, EMAX, and NSAMP on the SAVE statement, which are 
used to specify the range of quantum well LED spectrum coming from QWELL model. You have an 
option not specify them at all, which will cause ATLAS to choose the range automatically, based on 
the maximum and minimum transition energies, with nsamples=1000. You can also specify only 
some of these parameters, in which case, other parameters will be chosen automatically.

• Enabled loading of the stress tensor from ATHENA structure files.
• Added strain dependent bandgap model.
• Added strain dependent mobility moodel.
• Added stress parameters (StressXX, StressXY, and StressYY) to the TIF format structure file 

reader.
• Added stress dependent mobility enhancement from input structure file.  
• Put in a lower bound on stress dependent mobility enhancement. 
• Implemented initial version of phase change materials. The model is implemented for CONDUCTORS

by specifying PCM on the MODELS statement for regions associated with the model behavior. 
• Added latent heat to the PCM model.  The latent heat is specified by the PCM.LATHEAT parameter 

of the MATERIAL statement.
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• Added C interpreter version of phase change material (PCM) hysterisis model. The F.PCM 
parameter of the MODELS statement is assigned to the file name containing the function.  The 
function returns resistivity and latent heat as a function of time, temperature, and history.

• Introduced the parameter PCM to the METHOD statement. This parameter resets several METHOD
parameters to improve PCM simulations.

• Added calculation of semiconductors resistivity to structure file output for PCM simulation.
• Added activation energy per the Johnson-Mehl-Avrami equation to PCM material transition time. 

For crystallization the parameter PCM.CEA on the MATERIAL statement specifies the activation 
energy in eV.  For melting (amorphization), the parameter PCM.AEA on the MATERIAL statement 
can be used.

• Added RESISTIVITY to the PROBE statement for probing material resistivity. For semiconductors, 
this is given by 1/(Q*(mun*Nd+mup*Na)).  For metals and conductors, it is given by the resistivity 
including the effects of phase change for PCM materials.  The resistivity for insulators is zero.

Virtual Wafer Fab
• Add support for optimization. The following algorithms are supported:

• Levenberg-Marquardt
• Hooke-Jeeves
• Simulated Annealing
• Parallel Termpering
• Genetic Algrithm
• Differential Evolution

• Offer target language to allow defining complex optimization targets.
• Added simple curve viewer
• Added support for the LSF queuing system.
• Added support for SMARTSPICE, SMARTVIEW, and QUEST.
• Allow selecting deckbuild and tool versions.
• Provide multi-level (cascaded) evaluation of the DOE tree for all re-entrant simulators.
• Automated backup strategy.
• Multiple files of different nodes can now be displayed within a single instance of TONYPLOT.
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Interactive Tools
DeckBuild

• There has been a major extension to the GUI. A menu and full popup support for has been 
implemented for all commands in the QUEST simulator.

• DECKBUILD has been modified as necessary for use by the VWF II tool.
• A commands menu and popup support for VICTORYDEVICE has been implemented as a clone of the 

ATLAS support.
• Syntax errors in DECKBUILD commands usually produce a popup with a message about "Monitor 

string detected". This is rather opaque. A line has been added to the message suggesting that 
you look for syntax errors in the DECKBUILD commands.

• The LOOP command has been enhanced to deal with expressions.
• A  -lsf (Load Sharing Facility) command line option has been introduced. This  option should be 

used when running on LSF systems to avoid certain issues with permissions.
• A number of new electrical parameters have been introduced in the EXTRACT module, such as 

acceptor initial bump state density.
• The following tools are supported in DECKBUILD:

• ACCUCELL

• ATHENA 1D
• QUEST

• SPIDER

• UTMOST IV
• VICTORYSTRESS

• Commands to TONYPLOT and TONYPLOT3D are now properly differentiated.
• Extremely long lines generated using continuation characters (typically model cards in ATLAS 

decks) no longer cause DECKBUILD to hang.
• DECKBUILD now correctly ignores comments in ATLAS model cards.            
• A second "go quest" command now restarts QUEST as required.
• Comment lines with a plus at the end are no longer recognized as continuation lines by any 

simulators.
• The DECKBUILD optimizer now handles continuation lines correctly.
• Killing a simulation in a loop no longer fails to to reinitialize the loop on restart.
• EXTRACT now handles correctly a cutline that passes through two parts of the same region which 

are separated by a vacuum.
• EXTRACT commands spread over multiple lines now work correctly when executed during a QUEST

run.
• EXTRACT now correctly recognizes user-defined materials.
• EXTRACT now recognizes Hydrogen as a valid impurity.

Tonyplot3D
• Now have Japanese GUI and Japanese User's Manual
• Added Plot Options for Doping: Absolute and n/p types.
• Added a junction feature for IsoSurface when Plot Options (Doping)→n/p types is selected in 

the Preference settings.
• Added the junction feature for net doping in IsoSurface.
• Added the feature to restore the IsoSurface(s) information in the setting file.
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• Added the feature to restore the camera position, zoom, light, material color, and contours in the 
setting file.

• Added the command to generate predefined pictures or results. For example:

tonyplot3d structure.str -set myset.set -png structure.png

• Added the feature to cut the substrate electrode (zero thickness) and export the cutting results into 
2D slice in TONYPLOT(2D).

TonyPlot
• Added support for plotting raw VWF file type.
• Added optional filtering of points for 1D VWF plots.
• Updated English manual.
• New Japanese manual.

DeckBuild PC
• Completely revamped example system, which now uses the same directory structure as the Unix 

DECKBUILD.
• Support for the ATHENA1D simulator

MaskViews
• Added Japanese language/manual support.
• Added support for the VICTORY product.
• Added labels to ATLAS mode.
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Analog / Mixed Signal / RF 
 Gateway

• Added a way to assign a defparam to a name.
• .defparam netlist option to allow result calculations to be passed down to subcircuit definitions.
• Support string literals as results, support IIF (Visual Basic style if).
• Added token identifier function parsing.

• User preference added to allow different pin ordering (alphanumerical, pin type, by verilog 
definition) for all netlisters.

• Added the ability to show the license details in the baseframe of the GATEWAY window.
• Improved Add wire stub feature to take pin direction into account.
• If the simulator changes to SMARTSPICERF, then do not reset Save macro checkboxes.
• Support pass-through (duplicate) pins with different ranges.
• Netlisting and simulation are now based on the active simulator that is specified in the user 

preferences or on the new Design Browser.
• Due to some addition of features and the new Design Browser, some of the menus have moved or 

been renamed. These new menus include:
• Simulation→Netlist (simulator based)
• Simulation→Run (simulator based)
• Simulation→Change Simulator

• The ATLAS main menu has been removed, and netlisting and simulation are all under the 
Simulation menu when ATLAS is set to the active simulator.

• Guardian and LVS netlist actions are under the Layout menu.
• GATEWAY200 version is released that allows full function but limited design scope capability.
• IMPORT→SPICE Function

This imports a file or files containing SPICE subcircuit definitions.    

Upon importing, GATEWAY will give you the choice of whether to create a new symbol library or 
update (attach) to an existing library.

• CREATE (generate) option - You specify the name and path of a new library:

GATEWAY will create and format the symbols, complete with pins, and spice strings 
automatically formatted.

14 different standard footprint shapes are available, and there is an internal filter that will 
match logic symbols with correct shape     

• UPDATE option - Updates symbol definitions from a subcircuit file 

If you have a standard EDIF symbol library from foundry or vendor, you can use 
IMPORT→SPICE to format all of those symbols by giving it a definition to match your model/
subcircuit file while leaving the vendor/foundry footprints alone.

• IMPORT→Verilog  

Performs the same functions as the IMPORT→SPICE except will work for verilog module files, 
and will create new symbols or attach to existing EDIF vendor/foundry symbols.

• Pins have added property to assign Verilog discipline.
• Pin direction attributes for Verilog netlisting.
• EDIF Export option to suppress GATEWAY sheet frames.
• Simpler and faster wiring algorithm for auto-routing wire connections.
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• “Show Name Only” listing for extra visibility on inherited nets.
• Design Browser for traversing a design hierarchy.
• Tree-based architecture
• Ability to choose the simulator (and netlist type for the design)
• Based on simulator to show the active views for that simulator
• Shows whether the domain is digital or analog at each instance
• From the right mouse menu, you can

• edit symbol
• edit symbol instance properties
• goto symbol definition (new):

• embedded definition (.model, .module, or .subcircuit entered and stored within .symbol 
file itself)

• attached file defnition (browse to the file, or use $$library\filename and use a definition 
there)

• generated from schematic definition (representing the schematic view)

• Symbols always have had a VALUE attribute. Now the instance dialog has a new column field 
named default that shows up next to the value field, making it easy to revert back to the default 
symbol attribute by the click of a button. Also, all instance attributes may be reverted back to their 
defaults with single click of a button.

• Wires have a new Type attribute for assigning verilog net declarations.
• LVS preferences enhanced for additional netlist components.
• Ability to add header and footer to netlist.
• New Generate Symbol utility

• Can add/remove pins
• Can move pins around the footprint
• Can Choose between 14 different symbol footprint shapes
• Can Custom size of pin text and pin placement

• Add wire stubs on multiple selection of symbol instances.
• You can switch simulators through the user preferences or from the toolbar on Design Browser.
• DC Bias dialog added to the post process menu to view all the DC Bias values in a list.
• HSPICE and AvanWaves interface added for simulation and post-processing.
• SMARTSPICE Rubberband simulation interface and capability.
• Simulation, Layout, and Postprocessor status bar on GATEWAY baseframe.
• SILOS added as supported simulator for Verilog.
• Additional preferences added for the ATLAS simulator.
• Encryption support for data files.
• SMARTSPICE circuit Rubberbanding feature launches directly from GATEWAY.
• Backannotation of transient runtime values can be dispalyed for each branch current and node 

voltage for any transient time.
• Device parameters (post-simulation) now can be displayed on the schematic next to any instance.
• GATEWAY now can run HSPICE directly from the schematic interface.
• GATEWAY lists HSPICE as a simulator option in the Preferences.
• GATEWAY lists AvanWaves as a waveform viewer option in the Preferences.
• The list of supported simulators under GATEWAY includes:

• SMARTSPICE

• SMARTSPICE200
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• SMARTSPICERF
• HSPICE
• ATLAS

• The list of supported waveform viewers under GATEWAY includes:
• SMARTVIEW

• TONYPLOT

• AVANWAVES

• First release of GATEWAY200 -- Fully featured version of the GATEWAY schematic editor limited 
ONLY by a circuit size of up to 30 transistors and/or a total of 150 circuit elements.

• Some of the pulldown menus have been re-grouped for the netlisting functionality. You may need to 
update your shortcuts.

• The Simulator Preferences have been changed. Choosing a simulator from the pulldown menu will 
determine what netlist GATEWAY generates when Simulation→Create Netlist is selected.

• Added backannotation of branch currents and node voltages to any time t.

This feature works when you press the V or I on the toolbar. There is a new Bias Display window 
pane that shows the time and step. To annotate to a time, run the simulation, enter a time, and 
press Display. To step through time at a specified interval, enter the step interval and press Step
as many times as needed. 

Note:  All values are calculated at DC to solve the matrix, but transient values will only show if those currents or 
voltages or both have been saved. To save them, mark them with cross probes, or use the save macros, or 
specify what to save in the control file.

• Added backannotation of SPICE device parameters to schematic.

This feature allows you to enter device parameters in the master symbol to be shown next to each 
schematic instance during simulation. Open the symbol file for edit and go to the Device 
Parameters tab. Enter the name of the parameter there and set visibility as desired. Those 
parameters will show on each instance of the symbol. Or, go to a specific instance after the 
simulation and open the Instance Attribute dialog. There, click the Device Parameters tab and 
click on the parameters you want to see for that instance.

• Fixed expansion of multi-bussed strings. 
• Fixed new symbol attribute alignment.
• Fix case-preservation of cell names in external libraries on EDIF import.

Note:  If versions between 2.8.0.R and 2.8.10.R have been used, there is a chance that some of the pin behaviors in 
the .symbol files may not have been fully converted. If you noticed any pins that were marked with 
"unconnected_OK" or "implicit" behavior that show incorrect net names on the schematic 
instances, close the schematics and don't save them. These symbols may need to be checked for the 
correct desired pin behavior in the symbol library. If corrections are needed, make them, and then open the 
schematics. Versions 2.8.11.R and forward did not have this issue.

• Added the ability to disconnect instances and wires from the schematic to disable for netlisting.
• Fixed issues in the parser with comma delimited and array operators.
• Improvements to bus and connectivity engine.
• New ATLAS menu for directly running ATLAS through DECKBUILD from the GATEWAY GUI.
• Added the ability to run TONYPLOT from the GATEWAY GUI.
• Complete set of Smartspice RF dialogs for ease of workflow in the SSRF environment to include:
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• ENVELOPE analysis
• HAC (Periodic Steady-State AC Analysis)
• HARMONIC (Periodic Steady-State Analysis)
• HNET (Periodic Steady-State Two-Port Analysis)
• HNOISE (Periodic Steady-State Noise Analysis)
• HOSCIL (Periodic Steady-State Oscillator Analysis)
• HTF (Periodic Steady-State Transfer Function Analysis)
• SPAC (Quasi-Periodic Steady-State AC Analysis)
• SPECTRAL (Quasi-Periodic Steady-State Analysis)
• SPNET (Quasi-Periodic Steady-State Two-Port Analysis)
• SPNOISE (Quasi-Periodic Steady-State Noise Analysis)
• SPTF (Quasi-Periodic Steady-State TF Analysis)
• PSS-Shooting (Periodic Steady-State Oscillator Analysis by Shooting Method)
• PSS-HB (Periodic Steady-State Oscillator Analysis by Harmonic Balance Method)
• PHASENOISE analysis

• The File→Export Design utility on windows must have:
• winzip installed in order to export to a *.zip file.
• tar in your path to export to a *.tar file.
• the tar command must support the -z compress option for a *.tar.gz file.

• Marker bubbles for DC bias and cross probes have new opaque, transparent, or invisible backdrop 
settings. This is available in the user preferences.

• GATEWAY netlist generation for TCAD ATLAS MIXEDMODE Netlisting:
• Symbols have ATLAS string.
• ATLAS netlist menu.
• ATLAS control file for model information.
• New ATLAS menu in the user preferences for options for running ATLAS 3D and other 

settings.
• NDL Netlist-Driven-Layout enhancements:

• Added NDL control file for NDL parameters.
• New NDL menu in the user preferences for netlist generation options.

• Support for special PDK NDL symbols.

SmartSpice
• Parallel SMARTSPICE

• Command Option -mp (multiprocessing for analysis sweep)
• Command Option -mps (transient sweep multiprocessing)

• Enhanced .biaschk statement functionality
• .LIN (Linear Network Analysis) added
• Monte-Carlo support in .OP analysis
• Improved Remote Alter Processing
• .RTTEMP analysis improved
• Enhanced Spectre Compatibility
• Enhanced HSpice Compatibility
• New default solver - XMS
• AUTOSTOP option enhancement - support for RT expressions in the .MEASURE statement
• S (Multi-Terminal Networks) device improved
SILVACO, Inc. 1-23



What’s New in the 2010 Baseline
• FSDB output file format now supported
• Improved warning management in RES device
• Rubberband feature
• Mismatch Analyses

• DCMatch Analysis
• BSIM-CMG model support
• SOA (Safe Operating Area) check feature
• Runtime Device Multiplier (M) support for select devices
• Improved TMI
• Improved CMA
• Loop Stability Analysis

Verilog-A
• Support parameter SOURCE in .model card
• Improved Verilog-A ddx operator
• Improved Verilog-A performance
• Support free MinGW gcc compiler on Windows
• Support partially encrypted Verilog-A source file

SmartSpiceRF
• Reliability and capacity, accuracy and convergence, user control of accuracy tolerances, helpful 

error and warning messages, graphic user interface have been improved.
• Simulation speed has been improved by increasing efficiency of component models, time-step 

control algorithm, and better control of numerical errors in both time- and frequency-domains.
• GATEWAY/SMARTVIEW design flow communication has been improved.
• Multi-threading license scheme improved.
• Support of Solaris x86 platform has been added.
• Possibility to load PSF data file has been added.
• Evaluation of time-domain defined sources for one-tone and multi-tone Harmonic Balance 

analyses.
• Memory allocation and management for Harmonic Balance has been enhanced.
• Possibility to automatically Choose/Switch Harmonic Balance solver upon circuit size and given 

analysis parameters has been implemented.
• Support of Touchstone Version 2.0 file format data.
• Calculation and output of Unconditional Stability criterions M and M' for two-port network 

analysis have been added.
• Simulation flow for high Q oscillators has been improved.
• Oscillator simulation flow has been enhanced with multiple parametric sweeps to obtain multi-

dimensional coarse/fine tuning curves.

Harmony
• The return code from the command line version of the program has been modified. The program 

will now return '+1' if there were no errors or only warnings and the return code will be '-1' if there 
were any errors found during the simulation run.

• The command line version of the program now supports UNIX/POSIX return values (i.e., '0' no 
errors, '1' errors occurred).

• The command line argument +alt_return_value can be used if the return values of prior 
versions of the program are desired.
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• The program will the give the user the option to switch to the project or open an edit window if a 
project file (.spj extension) is opened using the menu item File→Open....

• New command line argument +no_sdf_zero_delay_msg. This command line option will 
suppress SDF zero delay annotation warnings.

• Allows Spice bus notation in subcircuit definitions.
• Added program preference option to show or hide the command line window.
• A new code coverage report has been added, Branch Coverage, this reports lists coverage of "if", 

"case" and ternary statements. See the User’s Manual for more information on this report.
• Waveform Viewer Option. User can now select SMARTVIEW or the built in Analyzer as the waveform 

viewer. See the menu item: Edit→Preferences→Waveform Viewer.
• Two new menu items have been added to the Edit menu.

• Edit→Add Spice .INLCUDE card.
• Edit→Add Spice .LIBRARY card.

Note:  The Edit→Add Spice items will be active if a "Spice" type file is open in the Editor. Each item will open a file selection 
dialog that allows the user the select the file to be included in the .INCLUDE or .LIBRARY card that will be added 
to the open file.

• Command line option +nosave added to program. Using this option will change the virtual 
memory allocator so that a larger amount of virtual memory may be available to the program.

Note:  This option will disable the Save/Restore Simulation feature.

• The code coverage report dialogs have been replaced with dockable windows that contain the same 
information.

• Added Support for SILVACO standard encryption and decryption.
• Allows the user to simulate a source file without creating a project.
• Analyzer - Map zoom markers to middle mouse button.
• Analyzer - Link mouse scroll to listbox when mouse is over waveform window.
• Analyzer - Added alternate line background color
• HARMONY should support sweep command for the .TRAN statement for multiple runs.
• HARMONY now supports spice command sweep as an argument of the .TRAN statement for multiple 

runs. Please see the description of the .TRAN statement in SMARTSPICE User's Manual, Vol.1, 
section 2.13: Dot Statements for the detailed use of the parameter sweep. If the Spice sweep 
command is used, the waveform viewer "Analyzer" is disable. Simulation data (raw file) can be 
viewed using SMARTVIEW.

• When using the GUI version with the sweep option, and the input deck also contains 
postprocessing cards (.print or .measure), the data for the final sweep step will not be written to 
the SMARTSPICE output file "_temp.out" until either the project is closed or the program is closed.

• HARMONY includes the Lint functionality of TURBOLINT. Designers can use Lint to make 
comprehensive syntax, semantic and design rule checking with over 500 build-in checking rules. 
Lint can also check for simulation and synthesis mismatches, race condition, clock domain 
synchronization and more (user defined).

• Create a backup of the project (.spj) file on startup.
• Added file type .vams to open files selection.
• Added Display as Analog to Analyzer pop up menu.
• Combine Set Trace Color and Set Strength Color Coding into one menu Change Trace Color.
• Support CDL Format "/" in X calls & SUBCKT definitions.
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• Added State Change Hazard Detection feature to analyzer. State Change Hazards are now 
indicated using red blinking dots.

UTMOST III
• New U.Meas routine: Universal Measurement routine. Bip, MOS, TFT, SOI modules have routine 

numbers from 120 to 129 available to generate data in UTMOST IV format file.
• New AL_IDVGB routine: Multi Geometries routine to measure IDvsVG-VB.
• Diode ALL_DC Routine: Added support for Rubberband.
• Integrated UOTFT (Organic TFT) support in Model List.
• Integrated EKV3 support in Model List.
• Added External .LIB simulation feature.
• Added VerilogA simulation for for external SPICE ELDO simulator.
• Added Custom Instance Parameters feature as requested by HiSIM or PSP model.

UTMOST IV
• Fixed problem with copied search name not appearing in search manager.
• Disabled parameters are no longer optimized from the sequence.
• Fixed default sort fields in data acquisition projects.
• Fixed UTMOST III logfile import to read units of AD/PD as square meter and PS/PD as meter. 

Except for MOS routines CJ, CJSW, CJ/CJSW where the units  are square micron and micron.
• Improved algorithm for checking of linear sweep definition.
• Added support for import of TFT INTCAP CGC UTMOST III routine.
• Fixed issue when importing old format UTMOST IV project files.
• Added support for import of AL_IDVGD from UTMOST III logfile.
• Fixed problem when deleting multiple objects from project.
• Added preference to stop putting attributes into plot titles.
• Added openCurrentWorkingDirectory function to Fit Module.
• Added capability to export dataset into TCAD logfile format in Fit Module.
• Added capability to export model card into TCAD ssf format in Fit Module.
• Added feedback messages when running UTMOST IV Fit Module.
• New improved GUI for input of measurement setup conditions.
• New AC_TABLE dataset type supported.
• Added support for import of CGSO, CGDO, and CGBO UTMOST III routines.
• Added JavaScript functions for data acquisition projects in Fit Module.
• Modified UTMOST III logfile importer to handle new format for instance parameters.
• Can now import ATLAS/VICTORY format logfiles directly into UTMOST IV using the Fit Module.
• Now able to return independent and calculated data arrays from dataset in the Fit Module.
• Added dialog to report on progress during external hspice, spectre, pspice and eldo simulations.
• Optimization will now attempt to recover from a simulation failure.
• Can now specify optimization setup target to choose only primary sweep data.
• Model library now displays much faster when multiple models are present.
• Can now run UTMOST IV Fit Module from DECKBUILD.
• Improved robustness when the viewer is closed or killed.
• Can now run rubberband from the optimization sequence directly.
• Optimization sequence can now run without SMARTVIEW if necessary.
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• Fixed problem where revert was not correctly repainting the min/max column in Rubberband 
dialog.

• When simulation fails, the data is now cleared from the viewer.
• Fixed possible crash in model library window if entry row set to expression.
• Floating node check in dataset now fully case insensitive.
• Attribute order is now preserved correctly in netlist.
• Unsaved, iconized project now displayed when exiting UTMOST IV.
• Added support for import of AL_IGVBG from UTMOST III logfile.
• New export from model library to spayn CSV format file.
• UTMOST actions in SMARTVIEW now disabled while UTMOST is busy.
• Fixed function cyclic dependency checking.
• New script for conversion of old format bsimpro data.
• Improved derivative endpoint calculation.
• Added support for import of AL_IGVGD from UTMOST III logfile.
• Now able to import all subtest numbers for ALL_ISUB logfile import.
• Fixed model card overwrite case sensitivity issue.
• SMARTSPICE process is now closed when project is closed.
• Marked parameters are now unmarked when changed to expression.
• New LCR_TABLE dataset type supported.
• Can now accept measured data with NaN values.
• Improved data conversion scripts to work with multiple versions of awk.
• New conversion script for ATLAS DC logfiles.
• Improved ICCAP and BSIMPro conversion scripts for DC data files.
• New fit module providing fully customizable JavaScript scripting.
• New data acquisition by simulation module.
• New database manager festure for management of database objects.
• Improved optimization Library.
• Reduced inbreeding in differential evolution optimization algorithm.
• Improved robustness of UTMOST IV to errors from 3rd party simulators.
• Improved simulation coverage for third-party simulators.
• Improved robustness of simulation using best parameters after optimization.
• Marked parameters are now unmarked when disabled or their value/min/max combination causes 

them to become unmarkable.
• Fixed problem when simulating DC_TABLE datasets with large number of points.
• Asking for simulated or measured data name that does not exist now produces an error in the Fit 

Module.
• Added new HiSIMHUIGBT model template.
• Added UOTFT model card template.
• Fixed problem with import of ALL_ISUB pmos measurements with multiple VB values.
• Import of gummel routine from UTMOST III now supports multiple VC values.
• Added support for import of AL_IDVGB from UTMOST III logfile.
• Fixed problem when copying data subset or optimization setup.
• Fixed issue with Solaris 10 firebird database and complex query.
SILVACO, Inc. 1-27



What’s New in the 2010 Baseline
SPAYN
• Added language translation support for Japanese and Chinese.
• Added a new dialog with table of rejected samples (with Export option).
• Introduced new Wafer Map Die Import dialog
• Added new Parameters Units list feature.
• Link to VWF: Added Sensitivity Analysis feature (with Export option).

SmartView
• Digital signal display capability has been added and accepts both VCD and RAWD formats.
• Incremental loading mode added for RAWD and VCD files to save on Memory space used.
• Quick file reload functionality for new VCD and RAWD data to update display and vector 

information.
• Ability to Zoom and scroll combined Digital and Analog display charts.
• Digital color-coding style used for signals from RAWD file.
• Can set any color for digital signal line, color sequence.
• Added ability view digital data as a table.
• BUS trace on the legend is expendable to display separated signal bits on Digital chart.
• Added ability display Digital chart in Chart Preview Window where shows currently selected chart 

in an unzoomed state. 
• X Marker is available and synchronized on Digital and Analogue charts.
• Added ability snap X Marker to the nearest value on Digital chart.
• Data file can now be opened and displayed during SMARTSPICE simulation in HSPICE mode.
• Vector Calculator equation can be applied to multiple simulation results.
• Added multiple period/frequency measurements.
• Analog Real and Integer signals stored as event data in RAWD or VCD files can be transformed to 

analog vectors and displayed in Cartesian Chart.
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CUSTOM IC CAD
Expert

• Common
• 64-bit Linux/Solaris versions of EXPERT.

• Allow to run EXPERT in batch mode (no GUI).
• Viewing and Editing

• Tabbed view of two or more opened cells.
• Added new 'Split Array by Line' and 'Modify Corner' tools.
• Added new 'Grouping'.
• Toolbar repeatable tools.
• DRC Assist (warning about potential rule violations before they are created through distance 

display).
• Support hierarchy in Groups.
• Show parasitic capacitance and resistance of nets extracted by HIPEX.
• Improved interface for multipath wires creation including new "Snap to pin" mode.
• Multi-user access for shared project libraries.

• Technology
• Support layer rules for DRC Assist.
• Support of line styles for boundaries of shapes for layers.
• Improved import of Technology Files from other vendors (physical rules, contact devices and 

multipart path templates).
• PCells

• New script language (JavaScript) for pcells and scripts.
• Pcells Callbacks pcells Cache for quick project loading.

• NDL
• Layout Editor and Schematic Integration (highlights instances and nets in EXPERT and 

GATEWAY) .
• Provide a netlist and layout comparison.
• Support pin-order and pin-type information in netlist.
• Node-Probing for huge layouts.

• LVL
• Support a hierarchical comparison of layout versus layout.

• DRC
• Save GUARDIAN DRC errors in the Calibre ASCII DRC/DRC-H Results database format.

Guardian
LVS
• Processes the specific SPICE elements, such as independent sources, voltage and current 

controlled sources, transmission lines, switches, coupled mutual inductors, multi-terminal 
networks, user-defined elements.

• Recognizes and combines the high-shorted subcircuit ports in hierarchical LVS.
• Detects the floating subcircuit ports in HLVS comparison.
• Handles the parameterized subcircuits in HLVS.
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• Allows the user to specify the non-collapsible instances to prevent the instances from disappearing 
due to the device reduction, merging, or filtering.

• Controls the priority of parallel and series reduction of devices.
• Recognizes and handles the logic gates, such as INV, NAND, NOR, AOI, and OAI.
• Allows the user to filter the shorted and dangled subcircuit-devices.
• Supports the area, length, and width parameters of JFET/MESFET transistors and length and 

width parameters of bipolar transistors.
• Uses the LISA Scripts for calculation and comparison of subcircuit-device parameters.
• Interprets the SPICE subcircuits as primitive devices using .LVSBOX statement in the Initial 

Correspondence File.

NET
• Redesigned the inspection of the netlist nodes in layout. The inspection is made using HIPEX

database (HDB) directly instead of Node Database (NDB). Usage of HDB substantially reduces the 
search time and memory requirements, especially for huge designs. The Annotate layout checkbox 
has been removed from the Layout page because NDB became obsolete.

• Added the Use NDL net names checkbox to the Node Names page that makes Guardian NET use 
the net names which NDL tool transfers from the schematic netlist.

• Modified the Netlisting page of the LPE Setup dialog. New MOSFET LW attributes only checkbox 
has been added instead of the MOSFET source and drain attributes and MOSFET stress effect 
parameters checkboxes. This checkbox suppresses the output of MOSFET source/drain area and 
parameters (AS, AD, PS and PD).
The Coupling mode group box has been added for coupling extraction mode. If coupling mode is 
enabled, GUARDIAN NET takes the set of net names from the text field, and considers them as 
selected or ignored.
New Output parasitic net models checkbox defines how the parasitics will be output to the netlist. 
The Backannotate option group has been moved to a separate Backannotation and LVS page.

• Modified the Technology page of the LPE Setup dialog. The abilities to use internal script files for 
layer derivation, parasitic capacitance, and parasitic resistance extraction have been added. The 
scripts can be loaded to technology using the Load button, or unload from technology using the 
Unload button.
An ability to use JavaScript procedures for calculating capacitance property has been added. 

• Added the synonyms for pin names of generic devices.
• Modified the Parasitic Extraction page of the LPE Setup dialog. The BA names checkbox specifies 

that selected or ignored net names are the names from backannotated netlist.
The Incremental CDB, RDB checkbox specifies that parasitic capacitance and resistance databases 
will be written in incremental mode.
New RC reduction groupbox contains the options for the parasitic built-in RC reduction procedure. 

• Added the Backannotation and LVS page to LPE Setup dialog.
• Improved Node Probing and Node Search tools that allow the user to highlight and search the 

netlist nodes.

HIPEX
• Provides the special functions for well proximity and STI stress effect parameters calculation for 

generic devices. Two functions device_enclosure_vector and device_enclosure are used in 
LISA scripts for generic devices for this purpose.

• Added new HIPEX_MOSFET_LW_ONLY variable that determines whether HIPEX-NET extracts 
MOSFET L and W only or also extracts source/drain area and perimeter parameters.

• Added the new parameter /CONTACT to the SET_CELL_OPTIONS command. The parameter 
performs the clusterization of contact layers in the specified cell.
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• Allows you to use JavaScript functions in HIPEX-C for calculating capacitance property instead of 
a build-in equations or LISA procedures. Usage of JavaScript functions instead of using LISA 
procedures substantially reduces the calculation time and memory requirements.

• The option /contact_oversize in the rpx define_parasitic wire command became obsolete 
in HIPEX-R.

• Resistance parasitic extraction has been redesigned to reduce the processing time and memory 
requirements.

• Performs net-by-net RC reduction for obtained RC distribution. Two techniques are used for the 
RC reduction. The first one is based on the scattering parameter macromodeling method. The 
second one is based on the time constant reduction method. The reduction procedure is controlled 
by the NETLIST_CRC variable.

• Added new output mode for parasitic networks. Default behavior produces SPICE netlist with 
parasitic devices placed in a subcircuit where parasitic net begins. Additionally, another output 
mode that permits to output parasitic elements to a netlist as a separate subcircuit has been 
added. In this case, all parasitic elements of a net are outputted to the parasitic subcircuit. This 
parasitic subcircuit is instantiated to original subcircuit as X call.

• Added the synonyms for pin names of generic devices. Synonym names "D" or "DRAIN", "G" or 
"GATE", "S", or "SOURCE", "C" or "COLLECTOR", "B" or "BASE", and "E", or "EMITTER" can be 
used to specify drain, gate, source, collector, base, and emitter correspondingly. Synonym names 
"POS", "P", or "POSITIVE", and "NEG", "N", or "NEGATIVE" can be used to specify positive and 
negative pins. Synonym names "SUB", "SB", "SUBSTRATE", "BL", and "BULK" can be used to 
specify substrate pin.
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INTERCONNECT
QUEST

• Added Trapezoidal metal shape deposition capacibility.
• New interactive running mode under DECKBUILD.
• Can now run under VWF
• Replaced data analysis scripting from LISA to JavaScript.

CLEVER
• Added links to the dynamic solver library. Besides the original template C++ iterative solvers, we 

now have the capability to choose from a bigger pool of solvers. To use the solvers in the dynamic 
solver library, add the option "linearsolver=solvertype"in the INTERCONNECT statement 
where solvertype can be SMS, XMS, SPD, AMSAMP, AMSILK. SMS, XMS, and SPD are direct solvers. 
AMSAMP and AMSILK are iterative solvers with preconditioners AMP and ILK.

• Added syntex check function. This function is written for those who are not falimiar with the 
CLEVER syntax. When finished writing the Clever input deck, you can check the syntax before 
executing it. To check the syntax in batch mode, type  clever -syntaxcheck inputdeck. To 
check the syntax in DECKBUILD, type  go clever simflags="-syntaxcheck".

• Major improvements on memory management in meshing, etching, and deposition modules.
• Improvements on cyclic simulation while running capacitance extraction multiple times. 

Symmetric grid will be reused for the subsequent simulation.

ClarityRLC
• Rapid handling the netlists of arbitrary size and complexity.
• Handling of coupling capacitors and resistor loops without loss of generality .
• Improved reduction based on proprietary enhancements of Time Domain method.
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DIGITAL CAD
SILOS

• The return code from the command line version of the program has been modified. The program 
will now return '+1' if there were no errors or only warnings and the return code will be '-1' if there 
were any errors found during the simulation run.

• The command line version of the program now supports UNIX/POSIX return values (i.e., '0' no 
errors, '1' errors occurred).

• The command line argument +alt_return_value can be used if the return values of prior 
versions of the program are desired.

• The program will the give the user the option to switch to the project or open an edit window if a 
project file (.spj extension) is opened using the menu item File→Open....

• New command line argument +no_sdf_zero_delay_msg. This command line option will 
suppress SDF zero delay annotation warnings.

• `ifdef and `endif compiler directives that span a module declaration caused the following error 
message:
"file.v" (nn) : error 2.060 : matching `ifdef not found for `endif
"file.v" (nn) : warning 1.367 : ``endif` is not implemented - ignoring 
directive

• $sdf_annotate() system task will now create an annotation log file if the file name is specified 
as argument 4.

• Changed Code Coverage "operator coverage" to "expression coverage".
• Added line hit count to code coverage operator report.
• Added program preference option to show or hide the command line window.
• New code coverage report has been added, Branch Coverage, this reports lists coverage of "if", 

"case" and ternary statements. See the User’s Manual for more information on this report.
• Waveform Viewer Option. User can now select SMARTVIEW or the built in Analyzer as the waveform 

viewer. See the menu item: Edit→Preferences→Waveform Viewer.
• Two new menu items have been added to the Edit menu.

• Edit→Add Spice .INLCUDE card.
• Edit→Add Spice .LIBRARY card.

Note:  The Edit→Add Spice items will be active if a "Spice" type file is open in the Editor. Each item will open a file selection 
dialog that allows the user the select the file to be included in the .INCLUDE or .LIBRARY card that will be added 
to the open file.

• Command line option +nosave added to program. Using this option will change the virtual 
memory allocator so that a larger amount of virtual memory may be available to the program.

Note:  This option will disable the Save/Restore Simulation feature.

• Size report now includes information from the memory allocator.
• The code coverage report dialogs have been replaced with dockable windows that contain the same 

information.
• Added Support for SILVACO standard encryption and decryption.
• Allows the user to simulate a source file without creating a project.
• Analyzer - Map zoom markers to middle mouse button.
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• Analyzer - Link mouse scroll to listbox when mouse is over waveform window.
• Analyzer - Added alternate line background color.
• Allow multiple files to be selected for removal in Edit→Project Properties→Source Files Verilog 

Files.
• Source file will be updated automatically if it is modified and saved by tools outside of SILOS.
• Allow multiple library files to be added in one selection.
• SILOS is a new product that merges the Lint functionality of TURBOLINT with the SILOS-HDL 

simulator. Designers can use Lint to make comprehensive syntax, semantic and design rule 
checking with over 500 build-in checking rules. Lint can also check for simulation and synthesis 
mismatches, race condition, clock domain synchronization and more (user defined).

• Allow multiple files to be selected for removal in Edit→Project Properties→Source Files Verilog 
Files.

• Added Display as Analog to Analyzer pop up menu.
• Create a backup of the project (.spj) file on startup.
• Added State Change Hazard Detection feature to analyzer. State Change Hazards are now 

indicated using red blinking dots.
• Combine Set Trace Color and Set Strength Color Coding into one menu Change Trace Color.

AccuCell
• Added support for bipolar circuits.
• Added support for CCS Timing format.
• Added support for encrypted model files.
• Enhanced HSPICE & Spectre netlist & models support.
• Enhanced MPW support.
• Enhanced .tbl file format and auto generation.
• Enhanced support for integrated clock gating cells.
• Enhanced vital library generation.
• Enhanced verilog library generation.
• Enhanced speed and accuracy of delay & power characterization.
• Enhanced power characterization options.
• Enhanced automatic function extraction.
• Enhanced automatic vector generation.
• Enhanced multi-voltage support.
• Enhanced active driver characterization error vs slope.

AccuCore
• Added support for multi-corner .cfg files.
• Added Spectre support.
• Added support for tapless Vbb-controlled std cells.
• Added cdl netlisting support.
• Enhanced FAST_MODE processing speed and characterization accuracy.
• Enhanced pattern matching to support RC netlists.
• Enhanced Liberty .lib support.
• Enhanced SMARTSPICE communication link.
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HyperFault
• The return code from the command line version of the program has been modified. The program 

will now return '+1' if there were no errors or only warnings and the return code will be '-1' if there 
were any errors found during the simulation run.

• The command line version of the program now supports UNIX/POSIX return values (i.e., '0' no 
errors, '1' errors occurred).

• The command line argument +alt_return_value can be used if the return values of prior 
versions of the program are desired.

• The program will the give the user the option to switch to the project or open an edit window if a 
project file (.spj extension) is opened using the menu item File→Open....

• New command line argument +no_sdf_zero_delay_msg. This command line option will 
suppress SDF zero delay annotation warnings.

• `ifdef and `endif compiler directives that span a module declaration caused the following error 
message:
"file.v" (nn) : error 2.060 : matching `ifdef not found for `endif
"file.v" (nn) : warning 1.367 : ``endif` is not implemented - ignoring 
directive

• $sdf_annotate() system task will now create an annotation log file if the file name is specified 
as argument 4.

• Changed Code Coverage "operator coverage" to "expression coverage".
• Added line hit count to code coverage operator report.
• Added program preference option to show or hide the command line window.
• New code coverage report has been added, Branch Coverage, this reports lists coverage of "if", 

"case" and ternary statements. See the User’s Manual for more information on this report.
• Waveform Viewer Option. User can now select SMARTVIEW or the built in Analyzer as the waveform 

viewer. See the menu item: Edit→Preferences→Waveform Viewer.
• Two new menu items have been added to the Edit menu.

• Edit→Add Spice .INLCUDE card.
• Edit→Add Spice .LIBRARY card.

Note:  The Edit→Add Spice items will be active if a "Spice" type file is open in the Editor. Each item will open a file selection 
dialog that allows the user the select the file to be included in the .INCLUDE or .LIBRARY card that will be added 
to the open file.

• Command line option +nosave added to program. Using this option will change the virtual 
memory allocator so that a larger amount of virtual memory may be available to the program.

Note:  This option will disable the Save/Restore Simulation feature.

• Size report now includes information from the memory allocator.
• The code coverage report dialogs have been replaced with dockable windows that contain the same 

information.
• Added Support for SILVACO standard encryption and decryption.
• Allows the user to simulate a source file without creating a project.
• Analyzer - Map zoom markers to middle mouse button.
• Analyzer - Link mouse scroll to listbox when mouse is over waveform window.
• Analyzer - Added alternate line background color.
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• Allow multiple files to be selected for removal in Edit→Project Properties→Source Files Verilog 
Files.

• Source file will be updated automatically if it is modified and saved by tools outside of HYPERFAULT.
• Allow multiple library files to be added in one selection.
• Allow multiple files to be selected for removal in Edit→Project Properties→Source Files Verilog 

Files.
• Added Display as Analog to Analyzer pop up menu.
• Create a backup of the project (.spj) file on startup.
• Added State Change Hazard Detection feature to analyzer. State Change Hazards are now 

indicated using red blinking dots.
• Combine Set Trace Color and Set Strength Color Coding into one menu Change Trace Color.

CatalystAD
• Added .cfg command SUBCKT_KEEP_AUTOPOPULATE to simplify cell partitioning for design 

utilizing std cells.
• Added .tcl command analyze_boundry to simplify top level port definition for design utilizing 

std cells.
• Added .cfg command VERILOG_SEQUENTIAL_MODEL to control model type for sequential cells.

CatalystDA
• Added option '-spl' to support reading SPICE netlist as reference of pin orders.

Spider
• Various dataprep enhancements simplifying the flow improving routability and expanding one 

pass support while eliminating manual edits.
• Advanced multi-target Blockage, Pin & Via (BPV) processing for LEF data.
• Significant enhancements for off-grid and gridless pin cell libraries.
• Improved via management (stacking, overhang, asymmetry, via constraints.
• .load file enhancements include (clocks, lib, pif, outfile, ddl_tech, force_pin, 

force_diagonal, force_on_grid, power_name, ground_name, symmetry).
• Incremental import and compile now supported.
• Block mode support.
• Auto pins/port from verilog plus auto PG and "virtual" clock port drivers in all flows.
• Auto padframe generation from verilog + LEF flow.
• Multi-height cell libraries support.
• DEF ROW & TRACK floorplan import support including (post placement optimization, placement 

congestion "2D heat mapping", core utilization analysis).
• DEF pre-placement and pre-routing support including blocks, cells, pins and routing.
• Library fill cells including DEF ROW SITE specifics.
• DEF output support.
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Other
SEDIT

• SPICE Dialogs: Added SmartSpiceRF Analyses Manager. It includes Oscillator Analyses Manager.
• Find Dialog: Added visual functionality for regular expressions.
• Editor Area: Added context menu item to open a file.
• Preferences Security: Added functionality to clear lists of most recently used (MRU) files.
• Preferences Security: Now list of MRU files is not exported by default.
• Fixed BMH search algorithm.

SMAN
• Added Encrytion File support and Key management.
• Included the ability to configure Verilog-A libraries.
• Fixed copying of large files.
• Use of internal compression library instead of reliance on external TAR program.

SRDB
• A backup_all command has been introduced.
• The list users command now shows the groups to which the users belong and vice versa.
• The command-line prompt now carries level information.
• The list databases command is much more informative.
• The ordinary backup and delete database commands now work correctly.
• On Windows builds, the database server password is no longer echoed back to the user.

SFLM
• Added token card support. Token cards are HASP keys that contain an amount of time that a 

Token can be used. Therefore, you can buy time for an application to run by the hour.
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